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Annotation Scale: What are you waiting for? 

Steven Rick – Bentley Systems, Inc. 
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Consistent Drawing Production with Annotation Scale 

 

Annotation Scale is an optional scale factor that is applicable to various element types such as text and dimension elements, 
custom line styles and to the non-printing Sheet Layout element. Applying the annotation scale will ensure that when a scaled 
print is created, annotations are at the correct physical size relative to the print scale. 

Thus, Annotation Scale is essentially a "plot scale" that is applied to element types that need to be scaled to match the desired 
output scale of the drawing. 

What Annotation Scale is: 

 A model property unique to each model (design, drawing, or sheet) in a drawing file 
 The setting is dynamic 
 May be used to "size up" or "size down" 
 You define what data it is associated with during the placement of elements using the Annotation Scale Lock property 

(other than custom line styles which are global) 

What Annotation Scale is not: 

 Not meant to remain static (i.e. Settings Manager) 
- Change one setting changes all "influenced" elements 
- Manipulating working units for different "scales" 

 Does not work with patterns or tags 
 Cannot be set independantly on line styles (all or nothing as a model property) 
 Vertical applications may not use it directly 

Remember, it resizes elements relevant to a "plot scale" 

 

While Annotation Scale does not work with everything, it does work with a variety of different element types and features within 
MicroStation V8i SELECTseries 2. 

Annotation scale may be associated with the following types of elements: 

 Text, text fields and notes 
 Dimensions 
 Cells 
 Detailing symbol styles 

 Custom line styles 
 Sheet model boundaries 
 Reference file elements 
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A Model-based Control 

Annotation Scale is a model property. When creating a model you have the option of associating an annotation scale to the 
model. If you change the model’s annotation scale in the Model Properties dialog, any text, dimensions or cells that you placed 
with the annotation scale lock enabled in the tool settings, will automatically be scaled by that amount. 

When you change a model’s annotation scale, you are prompted whether you’d like to propagate the new annotation scale to 
existing annotations. Clicking Yes will resize the text, dimensions or cells based on the new scale. If you click No they will not be 
resized even if they were placed with the lock on. 

The annotation scale lock determines whether the Annotation Scale’s scale factor is applied to elements at the time of their 
placement. The scale lock toggle button is available in various places including the following: 

 Models dialog 
 Drawing Scale window 
 Tool Settings window 
 Locks pop-up menu 
 References dialog 
 Element Information dialog 
 Various settings dialogs (i.e. Text Styles, Dimension Styles) 

 

Annotation Scale: 

 Set in model properties 
 Default scale is determined by the seed file or seed model a model is based upon 
 Available for any type of model: 

- Design 
- Drawing 
- Sheet 

 Works with Undo 

Note: Model Properties is also where Line Style Scale is set 

 

    Exercise: Set the workspace 

1. Launch MicroStation. 

2. In the lower right of the File Open dialog, set the following workspace options: 

 User: BeTogether 
 Project: Annotation_Scale 
 Interface: Annotation_Scale 
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    Exercise: Create a model with Annotation Scale 

1. Set the Files of Type to CAD Files. 

2. Open the file named 01 – Annotation Scale.dgn. 

3. Open the Models dialog. Click the Models button to open the Models dialog. 

 

4. Create a new model named Annotation Model. 

 

 

 

 

 

 

5. Set the Annotation Scale setting to Full Scale 1=1. 

6. Click OK. 

7. Select the Place Text command. 

8. Activate the Annotation Scale Lock toggle. 

9. Place a piece of text with the annotation scale “influence”. 

 

10. Repeat the procedure placing a piece of text without annotation scale. 

11. Change the active Annotation Scale and observe the results. 

12. Review the other models in the drawing file. 
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Drawing Scale Window 

The Drawing Scale window is a dockable window that contains controls for viewing and/or modifying working units, the 
annotation scale factor, the Annotation Scale Lock, the active Auxiliary Coordinate System (ACS), ACS scale, and ACS scale 
lock. These settings are particularly relevant to the process of creating sheet models for drawing production. 

The Drawing Scale window may be used to change the Annotation Scale setting on the fly. It is available by selecting Settings > 
Drawing Scale to open the window. 

Drawing Scale window features: 

 Quickly change Annotation Scale 
 Dockable 
 Resizable 
 Provides access to Units and ACS 
 Customizable (right-click) 

 

The Annotation Scale Lock Toggle 

The Annotation Scale lock toggle may be found on the tool settings window for any tool that supports this feature (other than 
custom line styles). The Tool Settings window is automatically displayed when any command is chosen 

Annotation Scale lock toggle locations: 

 Model Properties 
 Place Text 
 Place Note 
 Dimensioning tools 
 Place Active Cell 
 Detailing Symbol Styles 
 References 
 Lock Toggles 

    Exercise: Observe the Annotation Scale lock toggle in various tool settings 

1. Make the Drawing Task your active task. 

2. Select the Place Text command. 

3. Observe the Annotation Scale lock toggle state. 

4. Repeat this for additional commands that support Annotation Scale. 
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Determine Your Annotation Scale Workflow 

Before you begin using Annotation Scale, you must determine your Annotation Scale workflow. How will you be using Annotation 
Scale? Will you be placing annotations in a design model, a drawing model, or a sheet model? What is the “scale” of the model? 
Is it a 1:1 or a scaled environment?  

Questions to ask: 

 Do you print from a sheet model? 
 Is your printing environment at 1:1 or a scale? 
 Do you use styles? 
 Do you use DGNLIB files to store styles? 
 At what “scale” were your custom line styles created? 
 Are your custom line styles at a uniform scale? 
 Do you have need to have some line styles scale and some not? 
 Is there a need to have multiple scales in the same model? 

By answering these questions you will begin to understand how annotation scale will impact your design environment and how to 
best fit your cad standards to the Annotation Scale workflow. 

This may require modifying the existing definitions for these types of elements in V8i. 

 

Creating an “Annotation” Text Style 

Creating settings with Annotation Scale in mind is an important part of an Annotation Scale workflow. For many years it has been 
common practice to exaggerate the sizes of saved text and dimension settings based upon printing at a scale factor. If text was 
to be 5mm in height on the printed output when the print scale was to be 1:100, the 5mm text would need to be multiplied by 100 
and thus placed at 500mm in height in the model. Now, when using annotation scale, the text can be configured and placed at a 
height of 5mm with Annotation Scale (of 1:100) automatically adjusting the text size.  

 

This would allow the same text configuration to be used at any scale to obtain the 5mm height that is desired on the printed 
output. 

    Exercise: Open the DGNLIB 

1. Select File > Open… 

2. Change the Files of Type to DGN Library Files (*.dgnlib). 

3. Navigate up one folder level. 

 

4. Open the DGNLIB folder. 
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5. Open the file named Annotation.dgnlib. 

6. Observe the working units in the dgnlib. Change the Master Unit to Meters. 

    Exercise: Create a text style for use with Annotation Scale 

1. Open the Text Styles dialog box:  

Element > Text Styles 

2. Create the following Text Styles: 

Name Font Height Width Justification Color 
Buildings Engineering .0050 .0045 Center Center 64 
Street Labels Engineering .0075 .0075 Center Center 68 

 

7. Close the DGNLIB.  
8. Navigate up one folder level. 

9. Open the DGN folder. 

10. Open the file named 02 - Intersection.dgn. 

11. In the Drawing Scale window activate the Annotation Scale lock set the active Annotation scale to 1:100.  

12. Label the streets and some of the white buildings using the appropriate text styles. 

13. Change the active Annotation Scale to 1:200 and observe the results. 

    Exercise: Add Annotation Scale to Existing Text 

1. Observe the 2 buildings shown. 

2. Zoom In on the center of one of the buildings. 

Observe that there are existing labels in these two buildings. 
This text was not made “annotatable” when it was placed. We 
will now add Annotation Scale to this existing text. 

14. Enable the toggles: 

For Text Style (set it to Buildings) and 
Annotation Scale (enable the Annotation 
Scale lock). 

15. Select the text within each of the buildings.  
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Text Fields 

As you place or edit text you can insert fields that represent content that is derived from attributes of an element, the properties 
of a model or the properties of a file. The value for the “content” of the field text is then maintained by MicroStation based upon 
one of these values. 

Fields based upon element attributes are updated to reflect changes whenever a change to the element causes the attribute to 
change. If a text field includes the area of a closed element, the text will automatically update to reflect any modifications to the 
element. 

A field can appear anywhere within a piece of text and can span multiple words or lines within multiple-line text. Fields based 
upon model or file properties are, in general, updated when the file/model is opened but this action is controlled through a model 
property. 

 Properties of the following types of objects can be used as sources for field content: 

 Elements 
 Models (i.e. active Annotation Scale) 
 Files 
 Placeholder fields 

Placeholder fields 

In addition to inserting fields in text, you can also insert placeholder fields in a cell or cell model. A placeholder field is a field that 
is waiting for a target. When the target is provided, it can re-evaluate and display its property value. In the absence of the target, 
the field simply displays its field name. The target may be provided by means of a link.  

For example, you might create a monument cell that contains a Place Holder Cell Properties field (origin). In the cell model the 
field displays the field name origin. When the cell is placed in another model and the fields are updated, the field displays the 
origin of the cell. 

 

 

 

 

Place holder field in the cell model (left). Place holder field in the target model (right). 

    Exercise: Observing Text Field behavior 

1. Open the file named 03 – Text Fields.dgn. 

2. View the content of the drawing. The text elements placed in the table are linked to the areas of the lots. 

3.  Select the Modify Element command.   
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4. Using the Modify Element command, adjust the size of one of the lots. 
5. Observe the resulting change to the area or the corresponding lot area label in the table. 
6. From the File menu, select the Save As command 
7. Save the active DGN to Subdivision.dgn. 
8. The new DGN file opens. 
9. Zoom  on the area of the title block as illustrated 

: 

 

10. Observe that the drawing name remained the same. This is a text field linked to the properties of the drawing. 

To update this field, you may do either of the following: 

In the Key-in browser enter the command: FIELD UPDATE ALL 

or 

 change the model property for field update 

 

    Exercise: Adding a Text Field to reflect the active Annotation Scale 

1. Navigate to the /Cell folder. 

2. Open the file named Borders.cel. 

3. Open the model named Title Block – D. 

4. Open the Models dialog and verify the following model properties: 

 Annotation Scale: Full Size 1:1 
 Update Fields Automatically: Enabled 
 Cell Properties: 

- Can be placed as a cell: Enabled 
- Can be placed as an annotation cell: Enabled 

5. Close the Models dialog box. 

6. Zoom to the lower left of the title block (the SCALE text element). 

7. Using the Text Editor add a Text Filed to the existing text string to reflect the model’s current annotation scale. 

8. Close the cell library. 

Note: We will revisit this cell/cell library later in the workshop! 
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Dimensions 

Dimensions also have support for the active annotation scale and an Annotation Scale lock toggle that is available in the 
tool settings window. The usage of Annotation Scale with dimensioning is very similar to that of text placement. Annotation 
scale, related to dimensions, has the ability to set the size for the following: 

 Dimension text  
 Terminators 
 Extension lines (updating) 

A word of caution is in order though. When placing a dimension with the influence of annotation scale, immediately the 
dimension text and the terminators will be affected. The extension lines are not acted upon until a change in the active 
Annotation Scale is made. This will then resize all three dimension components listed and may require some tweaking on the 
offset distance of the extension lines since the active Annotation Scale acts as a multiplier on their length. 

    Exercise: Observing a dimension with Annotation Scale 

1. Open the file named 04 – Dimensions.dgn. 

2. Open the model Building Model. 

3. Open the Dimension Styles dialog and observe the Architectural dimension style. 

Observe the text size in the dimension style’s properties. 

4. Change the active Annotation Scale from ¼”=1’-0” to ½”=1’-0”. 

5. Note the change in size of the existing dimension elements. 

6. Delete these dimensions. 

Dimensions are best placed in the final sheet! 

    Exercise: Using a dimension style with Annotation Scale 

1. Open the model Floor Plan 1. 

2. Place the Border cell (from the active drawing) in the sheet model. 

3. Attach the Building Model as a reference to the sheet. 

4. In the model properties, enable the Update Fields Automatically toggle. 

 

Note the changes to the text in the title block cell. 

5. Place a dimension in the sheet model. 

6. The dimension style was configured for a 1:1 printing environment and thus is scaled correctly for the printed output. 
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    Exercise: Using a dimension style in a “scaled” sheet 

1. Open the model Floor Plan 2. 

2. Place the Border cell (from the active drawing) in the sheet model using annotation scale (1/4”=1’-0”). 

3. Attach the Building Model as a reference to the sheet using a reference file Detail Scale of ¼”=1’-0”. 

 

4. In the model properties, enable the Update Fields Automatically toggle. 

 

5. Place a dimension in the sheet model. 

Make sure the Annotation Scale lock toggle is enabled! 

6. The dimension style was originally configured for a 1:1 print, not a scaled print. Annotation Scale took care of resizing 

the dimension components relative to the active annotation scale and thus is scaled the dimension correctly for the 

“scaled” printed output of ¼”=1’-0” (or a 48 scale print). 

 

Annotation Cells 

Annotation cells are cells that obey the rules of annotation scale. That is, when you place them with annotation scale lock on, 
they are scaled by the current annotation scale. 

When you create a model to hold cell geometry, you can opt for it to be placed as an annotation cell. On placement, the 
annotation scale lock, like the one for the text and dimensioning tools, becomes active. If the model’s annotation scale is 
changed, cells and any text in them will also scale. 

You should not put a dimension inside an annotation cell. This is because the dimension will display an incorrect value when the 
cell is rescaled. This happens when you change the model’s annotation scale and display the model through a reference using 
active annotation scale. When an annotation cell is rescaled, the normal geometry is scaled, but the dimension continues to 
display its original value. 

    Exercise: Working with Annotation Cells 

1. Open the file named 05 – Annotation Cells.dgn. 

2. Observe the active annotation scale (set to Full Scale 1=1) and the drawing content. 

3. Change the active annotation scale to 1:10. 



                    IBUG Fall User Group Meeting September 28th 2011 

13 
 © 2011 Bentley Systems, Incorporated.

 

4. Notice the changes to cells (trees), text, and custom line styles. 

5. Change the active annotation scale to 1:20 (this is the desired print scale). 

6. Open the cell library dialog box. 

7. Attach the cell library Annotation Cells.cel. 

8. Review the cell library dialog box. 

 

9. Take special note of the Annotation column added to the cell library dialog box. 

10. Try placing cells using the Annotation Scale lock toggle. 

11. Adjust the Annotation Scale and observe the results on your newly placed cells. 

Annotation scale for existing annotation cells 

For previously placed annotation cells, you can enable or disable annotation scale lock with the key-ins ANNOTATIONSCALE 
ADD and ANNOTATIONSCALE REMOVE. If a selection set is active, the key-ins apply only to those selected annotation cells. If 
no selection set is active, all annotation cells for the model are included. 

“Retrofitting” an existing cell library 

It is possible to take an existing cell library and modify the model property for the cells to include annotation scale. This can be 
done individually or for a selection of cell. To modify an individual cell, access the model properties for the cell. To modify the 
setting for multiple cells concurrently, add the Is Annotation Cell column to the Models dialog box. 

 

Right-click on a column heading to add the Is Annotation Cell category. 
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    Exercise: Add Annotation scale to existing cells 

1. Open the cell library for Annotation Cells.cel editing. 

Hint: an easy way to do this for an attached cell library is to right 
on a cell in the cell library dialog box and select Open for Editing. 

2. Open the Models dialog box. 

3. Add the column for Is Annotation Cell. 

4. Modify the annotation setting as desired for the models in the dialog. 

5. Re-open the drawing and view the cell library in the Cell Library dialog box. 

Reference Files 

References support active model annotation scale. You may have added annotations to design models that are referenced into 
sheets. You also may have added annotations directly to a sheet. If the annotations were too small, you would have changed the 
model's annotation scale, but that affects only the annotations directly on the sheet (the current active model). The annotations in 
a reference are not changed. The only way you could change the annotations was to exchange into the reference and scale 
them. 

In the MicroStation V8i SELECTseries editions, an active model’s annotation scale may be applied to annotations in references 
also. If you change the scale of the annotations on a sheet, the scale of the annotations in the references change as well. 

To make a reference's annotations use the active model's annotation scale, you must enable this option. In the References 
dialog there is a new column named Use Active Annotation Scale. If this column is not visible, right click in the column headings 
and turn it on. To turn on this option for a reference, click in this column to make a check mark. 

Note: Existing annotations in a DGN file created with earlier versions of MicroStation cannot be scaled automatically. 
To make them use their active model's annotation scale, key in ANNOTATIONSCALE ELEMENT SETDYNAMICFLAG. 

    Exercise: Working with Annotation Cells 

1. Open the file named 06 – References.dgn. 

2. Observe the street labels and the building labels. 

These are intended to be the same size text when represented on printed output. The issue is that each of the 
attached references has a different active annotation scale and these are different from that of the active model. 

3. To correct this issue, open the References dialog box. 

4. Observe the Annotation Scale lock toggle. 

Hint: You may add an Annotation Scale category to the references dialog by right-clicking over one of the 
existing categories. 

5. Select the desired references (Design and Topo). 

6. Click the Annotation Scale lock toggle and observe the results in the active model. 



                    IBUG Fall User Group Meeting September 28th 2011 

15 
 © 2011 Bentley Systems, Incorporated.

 

Custom Line Styles 

Custom line styles also support the use of Annotation Scale. This setting is available in the Model Properties dialog box. Line 
Style Scale lets you choose the scale for line styles (Global Line Style Scale or Annotation Scale) and set the active annotation 
scale. 

 

If the model’s Line Style Scale is set to Annotation Scale, all custom line styles are scaled by this scale factor. 

Locking a line styles scale 

If it is desirable to have a line style not scale, the lines style’s definition may be edited to prevent scaling. This change would 
affect Global Line Style Scale or Annotation Scale. This is set by changing the line style “physical” property. If a line style is 
physical, it does not scale. 

    Exercise: Setting a line style to be Physical 

1. Open the file named 07 - Line Styles.dgn. 

2. Observe the Rail Road Track line style. Try changing the active Annotation Scale. 

3. From the main Menu, select Element > Line Styles > Edit. 

4. In the Line Style editor, Select File > Open. 

5. Navigate to the folder: 

C:\Documents and Settings\All Users\Application Data\Bentley\MicroStation V8i (SELECTseries)
 \WorkSpace\Projects\BE2011\Annotation_Scale\symb 

6. Open the project’s line style resource file Line Style.rsc. 

7. Locate and highlight Railroad in the Name list. 

8. From the Edit menu, toggle on the Physical property. 

9. Save and close the Line Style.rsc file. 

10. Exit and restart MicroStation. 

11. Observe the new behavior of the Railroad line style. 
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A “Dynamic” Sheet 

An interactive or “dynamic” sheet model may be created for a standard sheet size for use at any printing scale. A sheet model of 
this type is created by making a sheet model, setting the annotation scale at 1:1 and inserting a “title block” cell that is an 
annotation cell. The title block cell may optionally contain annotatable elements within it. 

    Exercise: Creating a dynamic sheet model 

1. Open the file named 08 – Title Block.dgn. 

2. Attach the cell library Borders.cel from the project cell folder. 

3. From the cell library dialog box, select the cell Title Block – D, right-click over the cell name and select Open for 

Editing. 

4. Set the model property making this an annotation cell. 

5. You may want to observe the text field for SCALE that was created earlier to denote the model’s annotation scale. 

6. Return to the file 08 – Title Block.dgn. 

7. Place the cell in the sheet model. 

8. Change the annotation scale and observe the results. You can also try using this as a seed model! 

The Good, the Bad and the Ugly 

As you have seen, Annotation Scale can be a very useful setting in MicroStation. So what’s the catch? There are a few things to 
be aware of: 

The Good 

 Annotatable items are designed to work at different scales. 

The Bad 

 Changing scales is not a magic solution. You may need to manually adjust the placement of some elements as 
you change scales. 

The Ugly 

 Retrofitting existing drawings to work with Annotation scale can sometimes be a bit challenging and might not be 
worth the effort to change them. 
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Considerations 

There are a few things to consider when working with Annotation Scale in MicroStation: 

Working Scale 

 Work at 1:1. Stop exaggerating the scale of elements based upon your intended plot scale and start letting 
MicroStation handle the task for you. 

Text and cells 

 Text justification and cell origin points are more important than ever when considering using Annotation Scale. Set 
them wisely! 

Education 

 Educate the MicroStation users at your organization on the planned implementation of Annotation Scale. 

 

Key-in Options 

The following are some key-ins that you may find helpful when working with Annotation Scale in your workflows: 

 ANNOTATIONSCALE ADD 
 ANNOTATIONSCALE REMOVE 
 ANNOTATIONSCALE CHANGE 

and 

 ANNOTATIONSCALE SELECT ELEMENT 

Used to create a selection set from elements that have annotation scale 

and 

 CAPABILITY_MODEL_ANNOTATION_SCALE       192 /* Allow use of model's annotation scale value */ 
 CAPABILITY_MODEL_ANNOTATION_SCALE_LOCK  193 /* Allow use of model's annotation scale lock */ 

 

Configuration Variables 

Propogate vs. Not Propogate...that is the question! MicroStation V8i SS2 provides a variable which determines whether your 
changes to annotation scale propogate automatically. 
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 MS_ANNOTATIONSCALEPROPAGATION = NEVER 

 

Scales.def 

The active scales.def file is used to drive the Annotation Scale factor in the Models dialog box. This file is a two column text file 
that contains the scale name and the scale value. 

The Scales.def file: 

 The left column is the name that is displayed it the dialog box. 
 The right column is the scale that is used. 
 The two columns are separated by a semicolon ";" 

The location of the scales.def file can be set with the configuration variable MS_CUSTOMSCALEDEF. The default location of 
this file is \Workspace\system\data\. 
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